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Dear PMU Users … 
 

We are providing this information to help you get started accessing/using the PMU IT 

facilities such as Telephone, Data Network, Printers and Computer Systems...In 

addition ITD offers technical training for PMU employees in any of the following 

software:  

Note: All training sessions (Banner, Blackboard and Classroom Technology) will be 

announced before each semester by the Professional Development Program. 

 

 

MS-Outlook PMU Application for  employees to be used for work related communication 
MS- Word PMU Application for word editing 
MS-Excel PMU Application for spreadsheet 

MS-PowerPoint PMU Application for presentations. 
Blackboard PMU Application for E-learning. 
Smart board PMU Application for interactive display. 

Banner PMU Application for SIS, HR, Finance, Financial Aid and Luminous resource 
management. 

TAA Time Attendance Application for staff only. 
LMS Library Management System for Students, Faculty and staff. 

Intranet Designed to Faculty and staff to access most of internal services quickly. 
E-Forum E-Forum is an online place for PMU Community. 

 

The department will include a new set of applications to the above list. So, if you have 

any questions or require more information, please email your inquires to; 

      it-helpdesk@pmu.edu.sa
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PMU’s Vision for Technology Excellence 
 

The ultimate goal of Prince Mohammad Bin Fahd University is to enable a learning-centered 
environment that is both effective and rewarding. 
 
In order to accommodate this noteworthy goal, the vision of the university’s Information Technology 
Department is to provide state-of-the-art methodologies and technologies that support the diverse 
needs of our students, faculty and staff. 
 

The Information Technology Department provides support in the following key areas: 

1. Student Technology:  A variety of technological tools are in the process of being provided to 
students including email, internet, wireless access, and availability of computer lounges within 
both the male and female campuses. 

2. Classroom Technology:   Automated learning aids are available in each of PMU’s many 
classrooms and include video conferencing, Interactive Boards, and automated teaching 
systems supported by advanced learning applications. 

3. Library Information System:  Upon completion of our Learning Resource Center (LRC), an 
integrated library automation system will be available to students in order to access an 
extensive library collection. 

4. Management Information System:   Our MIS system enables faculty and staff to provide 
quality support to students in the areas of registration, finance, human resources, course 
management and general student information. This world leading application called Banner 
from SunGard, is being implemented to be an easy web-0based self services. In addition, the 
course management system is being administered by the world leading Blackboard application 
which is being used as an educational instrument to have the interaction of the students and the 
instructors. It is accessible over the LAN and from any internet access point. 

5. Information Technology Infrastructure:   A dedicated team of IT specialists provide 
network and communications support, hardware maintenance, web design, and help desk 
services.  

 
This infusion of technology into the university environment enables students to obtain the 
information they need, when and where they need it, so they can effectively pursue their goals of 
academic excellence and professional competencies. 
 
In response to PMU’s goal, technology has become a critical tool for developing the skills necessary 
for our students to become future leaders within Saudi Arabia and elsewhere. 
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About your Account with ITD 
 

Logon and password 

To log on to the system, press [Ctrl][Alt][Delete]. For the User ID, type 
your first letter of your first name and your last “family” name (all 
without space). Be sure to use all lowercase letters. The first time you log 
on to the system, press the Enter key. The system will then ask you to 
change your password. Your password must be at least eight 
characters and must include at least one number or special 
characters in addition to letters Uppercase and Lowercase.  
Your new password is case-sensitive. 

Software Installed on your 
computer 

Standard desktop applications (Microsoft products tool 2007, 
Antivirus, e-mail, Web browser) 
 

Email 

Your email account has been setup using Microsoft Outlook; you can 
access your email out of the office premises using Internet Explorer by 
browsing to http://mail.pmu.edu.sa then enter your user name and 
password  

Printer 
The default printer(s) installed for your computer is a network printer or a 
personal printer. 

Computer Specifications 
Please refer to the IT Helpdesk G037 (Males) and G032 (Females) to get 
the information about the computer you will be using. 

Notebook Specifications 
Please refer to the IT Helpdesk G037 (Males) and G032 (Females) to get 
the information about the computer you will be using. 

Technical Support 
If you need any further technical support or having IT related issues, you 
may contact  our help desk  email it-helpdesk@pmu.edu.sa  

Telephone Extension Your telephone extension is showing on the top of your phone screen. 
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III. How to Use Your IPT 
     Telephone-Set - Startup Guide 

                       How to use IP telephone 7970 
 

 
 

  
  
 

 

Depending on configuration, programmable buttons provide access 
to: 
• Phone lines (line buttons) 
• Speed-dial numbers (speed-dial buttons) 
• Web-based services (for example, a Personal Address  
    Book button) 
• Phone features (for example, a Privacy button) 
   The buttons illuminate to indicate status: 
           Green, steady—Active call on this line (off hook) 
           Green, blinking—Call on hold on this line 
           Amber, steady—Privacy feature enabled 
           Amber, blinking—Incoming call ringing on this line 
           Red—Shared line, currently in use 
           No color—No call activity on this line (on hook) 

Programmable 
buttons 

 

 
 

 

1. 

Allows you to adjust the angle of the phone base. Footstand button  2. 
Awakens the touchscreen from power-save mode or disables it for 
cleaning. 
 

Display button 
 

 
 

 
 

3. 

No color—Touchscreen available, ready for input 
  

Green flashing—Touch screen disabled 
Green steady—Touch screen and backlight disabled 
 

 

Typically auto-dials your voice message service (varies by service). Messages button 
  

4. 

Opens/closes the Directories menu. Use it to access call logs and 
corporate directories. 
 

Directories 
button 

  

5. 

Activates the Help menu. 
 

Help button 
  

6. 

Opens/closes the Settings menu. Use it to control touchscreen 
appearance and ring sounds. 
 

Settings button 
  

7. 

Opens/closes the Services menu. 
 

Services button 
  

8. 

Controls the volume and other settings. 
 

Volume button 
  

9. 

Toggles the speakerphone on or off. 
 

Speaker button 
  

10. 
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 Icon Reference:  
Call Forwarding enabled 

 1  

Call on hold   2  

Connected call  3  
Off-hook  4  

On-hook  5  
Incoming call  6  
Shared line in use  7  
Authenticated call 

 8  

Secure call  9  

Handset in use 10  
Headset in use  11  
Speakerphone in use  12  
Messages waiting  13  
Speed Dial button configured 

 14  

Video enabled  15  
Option selected  16  
Feature enabled

 17  

  

  

Toggles the Mute feature on or off. 
 

Mute button 
  

11. 

Toggles the headset on or off. 
 

Headset button 
  

12. 

Allows you to scroll through menus and highlight items. Use in 
conjunction with softkeys to activate highlighted items. Also, while 
the phone is on-hook, press the Navigation button to access phone 
numbers from your Placed Calls log. 
 

Navigation 
button 
 

 

13. 

Allows you to dial phone numbers, enter letters, and choose menu 
items. 
 

Keypad 
 

 

14. 

Each activates a softkey option (displayed on your touchscreen). 
 

Softkey buttons 
  

15. 

Indicates an incoming call or new voice message. 
 

Handset light 
strip 
 

 

16. 

Shows phone features and date, time and caller number.  
 

Touchscreen 
 

 

17. 
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Telephone-Set - Startup Guide 
           How to use IP telephone 7911 
 
 
 
 
 

                                                           
 

 
 
 
 
 
 
 

1.  Phone screen         Displays phone features such as phone number, call status, 
and softkeys 

2.  Cisco Unified IP 
Phone series  

Indicates your Cisco Unified IP Phone series.  
 

3.  Softkeys Each softkey activates a softkey option displayed on your 
phone screen  
 

4. 

 

Navigation button 
 

Allows you to scroll through menu items and highlight 
items. When the phone is on-hook, displays your Speed 
Dials.  
 

5. 
 

Applications menu 
button  

 

Displays the Applications menu that provides access to a 
voice messaging system, phone logs and directories, settings, 
and services.  
 

6. 
 

Hold button 

 

Places the active call on hold, resumes a call on hold, and 
switches between an active call and a call on hold.  
 

7. 

 

Keypad Allows you to dial phone numbers, enter letters, and choose 
menu items.  
 

8. 

 

Volume button 
 

Controls the handset, headset, speaker, and ringer volume.  
 

9. 

 

Handset Functions like a traditional handset. The light strip at the top 
of the handset blinks when the phone rings and stays lit if 
there is a new voice message (depending on your voice 
messaging system).  
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   Telephone-Set - Startup Guide 
       How to use IP telephone 7941 
 
 
 
 
 

1 

 

 

Handset light strip  
 

Indicates an incoming call or new voice message.  
 

2 

 

Phone screen  
 

Shows phone features.  
 

3  Cisco Unified IP 
Phone series  

Indicates your Cisco Unified IP Phone series.  
 

4 
 

Programmable 
buttons 

 

Depending on configuration, programmable buttons 
provide access to: 
• Phone lines (line buttons) 
• Speed-dial numbers (speed-dial buttons) 
• Web-based services (for example, a Personal Address  
    Book button) 
• Phone features (for example, a Privacy button) 

         The buttons illuminate to indicate status: 
         Green, steady—Active call on this line(off hook) 
         Green, blinking—Call on hold on this line 
         Amber, steady—Privacy feature enabled 
         Amber, blinking—Incoming call ringing on  this line 
        Red—Shared line, currently in use 
        No color—No call activity on this line (on hook) 

5  Foot stand button  
 

Allows you to adjust the angle of the phone base.  
 

6  Directories button  
 

Opens/closes the Directories menu. Use it to access call 
logs and directories.  
 

7 
 

Help button 

 
 

Activates the Help menu 

8 
 

 

Settings button Opens/closes the Settings menu. Use it to control phone 
screen contrast and ring sounds.  
 

9  
 

Speaker button 
 

Toggles the speakerphone on or off. When the 
speakerphone is on, the button is lit.  
 

10  
Mute button  
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Telephone-Set - Startup Guide 

           How to use IP telephone 7941 
 
 

10.  Headset button 
 

Toggles the headset on or off. When the headset is 
on, the button is lit.  
 

11. 
 

 

Volume button 
 

Controls the handset, headset, and speakerphone 
volume (off-hook) and the ringer volume (on-hook). 
 

12. 
 

 

Services button 
 

Opens/closes the Services menu.  
 

13. 
 

 

Messages button 
 

Auto-dials your voice message service (varies by 
service).  
 

14. 

 

Navigation button 
 

Allows you to scroll through menus and highlight 
items. When the phone is on-hook, displays phone 
numbers from your Placed Calls log.  
 

15. 

 

Keypad  
 

Allows you to dial phone numbers, enter letters, and 
choose menu items.  
 

16.  

 
Soft key buttons 
 

Each activates a softkey option (displayed on your 
phone screen).  
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IV.   IT Support Services 

The Help Desk (HD) is the Single Point of Contact for Information Technology.  To request 

IT Services, have the PMU ID No- to contact the Help Desk:  

 Any technical problems related to network, Email, Classrooms labs, Printers and 

Hardware should be addressed to IT-HELPDESK@PMU.EDU.SA . 

 All  technical problems related to Blackboard and Banner queries and problems should be 

addressed to ITD-BB (Blackboard) – ITD-Banner(Banner) 

 All SMS request should be addressed to ITD-SMS. 

 All library Management System related problems should be addressed to ITD-LMS. 

 Part of our new service, all photocopier’s problems should be addressed to  

IT-HELPDESK@PMU.EDU.SA . 

 All inquires and concerns related to Lecture hall and Auditorium should be addressed to 

IT-HELPDESK@PMU.EDU.SA. 

 In addition to the above helpdesk guidelines, please feel free to call PMU Technical 

Support Center (TSC) at ext: 9290 in Male Campus or ext: 9214 in Female campus. Also 

you could stop by the Technical Support Center in Male campus at Room G037 next to 

ATM machine or room G032 in Female Campus. The general number for the IT 

helpdesk is 9299. 

 The PMU user contacting the HD or TSC must be able to provide:  

 Contact person should provide: PMU ID No, Name, Office No, Department  

 The location of the equipment  

 A detailed description of the problem if possible write the error message if it exists 

 A detailed description of what has been done to troubleshoot the problem if the user had 

tried already. 

 The best time to visit the contact person in his office, in case the problem should be 

handling in person by our technical team. 
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The Help Desk will ensure that all calls are handled promptly, courteously, and are resolved or 

routed to the proper resolution path within the time frame established for each type of call or 

problem. 

We can offer technical support for the following: 

 Employee Identifications card ( classrooms doors access or attendance card reader problems) 

 Assistance with software applications  

 Computer problems  

 Network solutions  

o password guidelines  

o change network password  

o setting up new accounts  

 Email solutions (mail tips (MS-outlook), virus-protection information)  

 Office moves/relocation (rearranges, adds and changes)  

 Telephone operation questions, IP telephony  

 Telephone programming requests ( add entry to PMU directory, remove one) 

 Assistance with new computer (recommendations, specifications, quotes, installations).  

 Assistance setting up printers  

 Remote access questions  

 Classrooms Program / technical problems 

 Installation of software, Ex: AutoCAD for Interior Design College faculty, C++ and Java for   

      IT College Faculty 

 Installation of computer hardware or printers  

 Meeting assistance requests  

 Outlook Profile  

The hours of operation for the Help Desk are 8:00 a.m. – 4:00 p.m., Saturday through Wednesday. 

If you have any questions or concerns, please call Help Desk Assistance Ext: 9299. 



IT Welcome Package, August, 2009                                                                        Page 13 / 56 

 

PMU/ITD/TT/NC/06002 (IT Welcome PackageEV2.1)                                                                               Final         

 
V.  Use you Outlook 

 
       In your web browser, in the Address or Location field, type http://mail.pmu.edu.sa and     

press <Enter>. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

2. Click the Log On button.  

3. Now you will be prompted to login.  

 For Example: Username, enter 200X00XXX@pmu.edu.sa  (your Banner 9 digit ID) 

                           Password, enter your Password.   

    Notes: - The password is case sensitive (capital letter and small letter) 

               - You can change your password from Change Password link. 
  

4. Set the Client Access Level to your desired level: 

 ♦ Premium client provides all Outlook Web features.    

 ♦ Basic client provides fewer features than premium but offers faster performance.  

5. Set the Security Settings:  

 ♦ Select Public or shared computer if you use Outlook Web on a public computer.  

♦ Select Private computer if you are the only person who uses this computer or it is a private,   

   residential computer.  

 6. Click Log On.  

Note: We recommend that you use Internet Explorer version 6.0 or higher as your web browser,    since all features 
do not work using Netscape, Mozilla, or earlier versions of Internet Explorer. 
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MICROSOFT OUTLOOK 2003 

Microsoft Outlook 2003 messaging and collaboration client provides the following capabilities: 

 Electronic mail 

 Personal calendar and group scheduling 

 Contact information and task list 

Outlook 2003 helps you organize, find, and view all of this information—all in one place. It is 
easy to  use, and like the other programs in the Office suite, provides an integrated approach to 
the Web. Outlook  2003 offers e-mail and collaboration features when used with Internet-based 
messaging systems and  even more advanced functionality when used on an intranet with 
Microsoft Exchange Server.  

EXPLORING OUTLOOK 2003 

When you open Outlook, you see the Inbox window. From here, you can access and read new 
e-mail messages, compose new messages, and take advantage of many of the tools that Outlook 
2003 offers. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Standard 
Toolbar 

Favorite Folders 

All Mail Folders 

Shortcuts 

Input Box 

Number of Items 

Preview pane 
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Calendar Is used to setup appointments, events and meetings. 

Contacts Is used to enter personal information, including e-mail addresses, of your contacts. 

Tasks Is used to create a list of tasks that need to be accomplished 

Journal Is used to log various tasks; for example, each time a document is opened, edited 
and saved in Word, it can be documented in this view 

Notes Is used to create reminders.  They resemble "sticky notes" and can be placed on 
the desktop of your computer 

 

 Deleted Items 

       Any notes, tasks, calendar items, journals, etc., that are deleted in Outlook will be saved in           
                   the Deleted Items folder.  

Note:  This will only store items that were originally created on the hard drive.  

The Deleted Items folder is different than the Recycle Bin on your desktop, but works in a 
similar way.  Until the items are deleted from this folder, they are not permanently deleted 
from Outlook. 

 Drafts: 

    When an e-mail message is saved before sending, it is stored in the Drafts fold until sent.  

 Sent Items: 

     As the default, e-mail messages are copied to the Sent Items folder after they are sent.  This is 
an excellent way to look back at history and determine if you have sent a message to an individual 
or not.   
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If you do not want to generate a copy of all sent messages, do the following: 

 Go into the Tools menu and click Options. 

 Select the Preferences tab. 

         Click the E-Mail Options button. 

 

 In the E-Mail Options dialog box, deselect the Save copies of messages in Sent Items        
                 folder box. 

 Click on OK to save the changes. 

Note: The setting will be enforced until the next  

           time you change it. 

 Outbox: 

      When sending a new e-mail message, 

      there are times when the server does not  

      send the message  immediately. Until the server 

       picks up the message, it is temporarily stored 

       in the Outbox folder.   

    

 

  Note: To send messages stored in the Outbox folder, click the Send/Receive button 

  on the Standard toolbar. 
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REPLYING TO E-MAIL MESSAGES: 

To respond to the sender of a message: 

 Open the message you wish to respond to.  

 Click the “Reply” button.  As the default, the original message will appear in the message 
window, the sender's e-mail address will appear in the "To:" box and the subject will 
appear in the "Subject" box. 

 Enter your response at the top of the message window.  

 Click the “Send” button to send the message.  A purple arrow  will now appear in the 
envelope icon next to the message. 

Note: To respond to everyone who received the original message, click the “Reply to All”  

    button on the toolbar.   
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FORWARDING E-MAIL MESSAGES: 

To forward a message to another individual: 

 Open the message you wish to forward to another individual.  

 Click the “Forward” button on the toolbar.  As the default, the original message will appear 
in the message window, and the subject will appear in the "Subject" box.   

 

 

 

 

 

 

 Enter the e-mail address of the individual you wish to forward the message to in the “To” 
box.  If you are forwarding the message to several individuals, separate each e-mail address 
with a semicolon (;).   

 If necessary, enter an additional message at the top of the message window and click the 
“Send” button to forward it.  A blue arrow will now appear in the envelope icon next to the 
message. 

 

 

 

 

 

 

 

 

 

 

 
 



IT Welcome Package, August, 2009                                                                        Page 19 / 56 

 

PMU/ITD/TT/NC/06002 (IT Welcome PackageEV2.1)                                                                               Final         

CREATING AND SENDING NEW E-MAIL MESSAGES: 

To create a new message: 

        From the Inbox folder, click the “New”   button to open an "Untitled" message 
window. 

 

 

 

 

 

     In the "To:" box, either enter the e-mail  

    address of the recipient, or click the “To” button 

    to open the Contacts list and select an address 

    of someone previously entered in your contacts list.  

     In the "CC:" box, enter the e-mail address of  

    someone you wish to send a "courtesy copy" to.   

 The "Bcc:" box is a "blind courtesy copy."   

This means no one else receiving the e-mail will know that this person has been copied.  If the Bcc 
box is not displayed, go into the View menu and select Bcc Field. Click the drop-down arrow 
beside the Options button  and select Bcc.  

    In the "Subject" box, enter a subject 

     related to your e-mail message. 

 Type your message in the space provided below.   

     After creating the message, 

     click the “Send”  button on the toolbar to send the message. 

 

 
 

New 
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ADDING AN AUTOSIGNATURE: 

To automatically have your signature appear at the bottom of each new message: 

    Go to Tools and select Options.  

    Click on the Mail Format tab.  

     Select the “Signature” button.  

     Click the “New” button to enter a new signature.   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The “Create New Signature” dialog box will appear.  

 Enter a name for the signature.  

Note: This is not how the signature will appear on the messages,  

            but rather a name which identifies the signature.  

 Click the “Next” button.  
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 Enter the signature line the way you want it to appear at the bottom of each message. 

  

 

 

 

 

 

 

 

 

 

 

 

 

 Click the Finish button then OK 

Note: From this point forward, all new messages 
will automatically contain your signature line at 
the bottom.   

 

 

Auto signatures can be applied to new 
messages and/or all replies and 
forwards.  To specify which options the 
signature should be applied to: 

 Go to Tools on the menu bar and 
select Options.  

     Select the Mail Format tab.  

 Click the drop-down arrow beside 
Signature for new messages and 

select the desired signature.  Select 
None if you do not wish to 
automatically apply a signature. 

 Click the drop-down arrow beside 
Signature for replies and 
forwards and select the desired 
signature.   

 Click on OK. 
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INSERTING ATTACHMENTS: 

Many times you will need to send files along with an e-mail message.  These files are called 
“Attachments.”   

To insert an attachment into a message: 

 Click the “Insert”  button on the Standard toolbar.   

 Browse to locate the file, and click Insert.   

 

 

 

 

 

 

 

 

 

Note: Icons representing the attachment(s) will 

be displayed at the bottom of 

 the new message window. 

 

 Send the message.  
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READING AND SAVING ATTACHMENTS: 

In your Inbox, a paper clip will be displayed next to each message that has an 
attachment.  After opening the message, the attachment will be displayed in the bottom 
section of the message window as an icon. 

 

To open the attachment: 

 Double-click on the attachment.  

 

 

 

 

 

 

 

 

 

To save an attachment to your computer: 

 Open the attachment.  

    Select Save button.   

   Select the destination where you wish to save the document.  Click on Save.   

Note: If the attachment is not opened, an alternative way to save the attachment is to: 

 Right-click on the attachment.  

 Select Save As.   

  Select the destination where you wish to save the file, click on Save. 
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FLAGGING MESSAGES: 

To flag a message for follow-up later, do the following: 

    Right-click on the message and select 

            Flag for follow up to open the “Flag For Follow Up”  

           dialog box.  Click on the drop-down arrow beside 

          “Flag To” to select the appropriate action that should  

           be taken.   

 Set a due date by when the message 

             should be responded to. 

 Click OK to flag the message. 

 A red flag will now be displayed next to  

            the message in the list of messages. 

 

     To view a list of all flagged messages: 

 Select view from the menu bar and click  

            on current view.   

 Select by follow up flag.  All messages will  

             be organized by the follow up that is required on each message.  

    Note:   To clear the flag after following up on it, right-click the message and select Clear Flag 
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    CREATING NEW FOLDERS AND ORGANIZING YOUR INBOX: 

    Creating a new folder 

 Folders are used within the Folder List to organize and group e-mail messages.  Before 
creating additional folders, consider how you wish to organize your messages.  For example, 
messages could be grouped by topic or by sender. 

     To create a new folder:  

 In the Folder List, select where 

                you wish to create the new folder.   

 After selecting the location for your  

                new folder, go to New on the standard toolbar  

                and select Folder.   

 In the Name text box assign the folder a name 

                that has not been previously used. 

 In the "Select where to place folder" list,  

                the location you previously selected should be listed.    

              Note: To change the location, simply select a different location.   

 

 Click OK, the folder should now be 
listed 

                                                                                        within the folder list.  
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   Moving Messages 

    You will need to organize your inbox by moving messages into the new folders that you 
have created. By moving messages to folders you created on your hard drive, you will be 
freeing space on the server.   

       To move e-mail messages from the in-box to these folders: 

 Select the messages you wish to move.  

 To select a block of messages, select the first message in the series, hold down the shift key 
on the keyboard and select the last message in the series.  A block of messages should be 
highlighted.   

 To select non-adjacent messages, select the first message,  hold down the control key on 
the keyboard, and click on additional messages.   

 Right click on the selected messages then choose “Move to Folder”. 

 Click on the appropriate folder then press OK. 
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CREATING GROUP DISTRIBUTION LISTS: 

Group Distribution Lists can be created to send an e-mail message to a group of people.  For 
example, if you frequently send messages to the IT department, you may want to create a 
distribution list called “ITD.” The list would contain the names of all members of the IT 
department.   

To create a group, do the following: 

 Click onto the Contact button. 

 Right click the mouse on the contact space 

   and choose “New Distributed List” 

 

 Write the name of the list you want to create  

    In the input box  

 

 Click the “Select Member” button 
to      display the list of current 
contacts. 

 Select the contacts you want to use 
in your group list, and then click OK. 

 Click Save and Close button to 
add the Group to Outlook’s Address 
Book. 

 

 

To send a message to the group:  

 Create a new message and click the To: button 

 The group will be listed within your contact list. 
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CALENDAR 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

To set calendar preferences: 

 With the Calendar folder open, on the Tools menu, click Options.  

                The Options dialog box opens. 

 Click the Preferences tab.  

 

 

 

 

 

 

 

To change 
appointment 
information 
quickly, click 
the 
appropriate 
appointment 
and type the 
new 
information. 
To change 
appointment 
information 
using the 
Appointment 
dialog box, 
double-click 
the 
appointment. 

Color coding 
shows further 
information about 
the appointment, 
such as if you 
will be out of the 
office or if the 
appointment is 
tentative. 

The current 
date is 
marked with 
a red box.  
The date 
shown in the 
daily planner 
panel is 
shaded. 

Click the 
arrow to 
show other 
months. 

Click to view calendar entries for today or a 
specific day, work week, calendar week, or 
month. 
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 Under Calendar, select Default reminder to have Outlook 2003 remind you automatically of all 

  appointments. Then, the drop-down box, select the amount of time before appointments you want  

  to receive the reminder.  

 

 

 

 Click Calendar Options. The Calendar Options dialog box opens. 

 

 

 

 

 

 

 

 

 

 

 

 Select the days of the week you want to show on your calendar. 

 Select other options as necessary. To select a time zone, or show more than one time zone at a 
time, click Time Zone. 

 To have Outlook 2003 automatically display holidays for different countries, click Add 
Holidays. 

 If you are responsible for coordinating resources, such as conference rooms, or classrooms, 
click Resource Scheduling, when you are finished, click OK. 
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ADDING TASKS 

A task is a personal or work-related errand you want to track through completion. A task can 
occur once or repeatedly (a recurring task). A recurring task can repeat at regular intervals or 
repeat based on the date you mark the task complete.  

For example, you might want to send progress reports to your students on the last Friday of every 
month. You can view tasks in one of two ways: 

  Open the Tasks folder.  

     

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Task symbols 

     

Accepted task 
 

Completed task 
 

Declined task 
 

High 
importance task
 

Low importance 
task 
 

  

Recurring task 
 

Task 

Task assigned 
to another 
person 
 

Task assigned to 
you 
 

Task has an 
attachment 
 

Task View: 
Changes the 
view in 
which 
Outlook 
displays 
your tasks. 

Click here to type task information 
in this row to quickly add a new 
task to Outlook without filling out 
the Task dialog box. 

Click a column 
heading to 
quickly sort your 
task list by the 
column. 

To change task 
information, click the 
appropriate task and type 
the new information. 
To change task 
information using the 
Task dialog box, double-
click the task. 
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To add a task: 

1. Click the Tasks folder to open it or  

2. Click New Task   the New Task dialog box opens. 

3. In the Subject box, type a description for the task. 

4. In the Due Date box, type a due date (optional). 

   Note:  You can also select a due date by clicking 

           the arrow next to the box and selecting a date  

          on the mini month calendar. 

5. To receive a reminder about this task before  

      the task is due, select Reminder.  

6. Select a status, priority, and percentage  

         complete for the task.  

7. To assign the task to a category, click  

      Categories and select a category from the list.  

8.  Save and Close. 

 

 

Note: You can rearrange the view of the tasks in several ways. To do so, on the View menu, point to 
Current view and then select a view option from the submenu. 
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OUT OF OFFICE REPLY 

If you would like an autoreply to be sent for emails you receive while you are out of your office, 
 follow these steps:  

 

1- Go to Tools menu, and then choose  
Out of Office Assistant. 

 

2- On top of the window there are two choices: 
        - I am currently in the office. 
        - I am currently out of the office. 

 

3- Choose the second one, and write the Auto Reply you would like. Then click OK 
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EMAIL ARCHIVE 

1- From the File menu, click on Archive. 

 

 

 

 

 

 

 2- On top of the window there are two choices: 
        - Archive all folders according to their AutoArchive settings. 
        - Archive this folder and all subfolders. 

3- Choose the first one and then click OK. 
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VII.How to Use your Wireless Connection: 

 
Make sure that the WiFi is ON in your laptop (some laptops had button to switch or key to 
press) 

 
1- Be sure that the Wireless network is enabled in your notebook: 

 
Start > Control Panel > Network Connections > Right click the “Wireless Network 
Connection” and enable it, if it’s enabled go to the next step.  

 
2- Double click the “Wireless Network Connection” you’ll find PMU Pubic wireless network. 
Double click the “PMU_Public” to connect. 
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3- Type “a1b2c3d4e5” for the Network key and in the Confirm network key. Then click 
Connect. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
4- You have to wait while it’s connecting… 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5- Then it will shows to you that PMU_Public are connected.  
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 



IT Welcome Package, August, 2009                                                                        Page 36 / 56 

 

PMU/ITD/TT/NC/06002 (IT Welcome PackageEV2.1)                                                                              Final 
 

 

VIII.  How to Setup your Internet Proxy 
 

1. Now we need to configure the Internet Explorer to access to PMU resources: 
Right click on the internet explorer  select Internet properties 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
2. Select Connections tab, make sure that you select  Never dial a connection   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
3. Select LAN Settings.  
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4. Configure the proxy as follow, proxy : 192.168.6.11 port : 8080 
  Note: If you are using at home, type the address received from your internet provider. 
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Changing Printing Preferences for Page Order 
 

    To change printers from printing the last page first in a multi page document follow the steps         
    below: 

 
1) Go to Start -> Control Panel -> Printers and Faxes then right click on the printer you are 

using and choose Properties.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2) Click on the Printing Preferences button. 
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3) Choose the Basics Tab and click on Back to Front radio button then press Apply then OK. 
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VII. How to Access Ebrary 
 
         1) Click the link on the website under PMU online services 
 
     
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
          2) Choose the E-Resources link 
 
 
 
 
 
 
 
 
 
 
 
 

4) Click on the E- brary link to access the electronic books. 
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5)  You will get the Site of Ebrary without any need for a username or a password. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Searching Ebrary 

 
 

1.Choose the search tab to search for books. 

Then type in a key word for the book you 

are looking for and click search. 

 

 

Example: 

If you are looking for and IT book, like 

 “Advanced Data Mining”, you can type 

 “Data Mining” in the search inbox.    
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2.Click on the book title you have selected. 
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3. If you are accessing the Ebrary for the first time, you will get a yellow message. 

 

 

 

 

 

 

4. Right click on it and choose “Install ActiveX Control”. 

 

 

 

 

 

 

5. It will ask you if you want to install the ebrary reader software, click on Install. 
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6. Select the option “I accept the terms ...”, and then click Accept. 

 

 

 

 

 

 

 

 

 

 

7. Now you can start going through the book you have selected. 

             (Note: you can select, copy, and print any of the pages you want.) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

8. Example: To copy a text, select it first then right click on it and choose “Copy Text” 
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Using the Ebrary Reader toolbar 

 

 

 

 

 

 

 

1. Info Tools menu.  

2. Copy text with automatic bibliographic citation.  

3. Print with automatic bibliographic citation.  

4. Go to previous/next page.  

5. Go to previous/next page containing search results.  

6. Go to page number or viewed pages.  

7. Zoom, scale or show facing pages.  

8. Add/edit bookmarks.  

9. Set highlighting and colors. 
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Creating a Personal Bookshelf 

Bookshelves allow you to automatically save and manage bookmarks, highlights and 
annotations as you conduct your research, providing a dynamic archive for future 
reference.  

 
To set up a Bookshelf please follow below steps: 
 

1. Click on the Bookshelf tab.  

 
 
 
 
 
 
 
 
 

Choose this  
link to create  
a new bookshelf. 

 
 
 
 
 
 

2. Enter the information needed then click on the “Create Your Bookshelf” button. 
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3. To log in to your Bookshelf type your user name and password for Ebrary, then click 

on Sin In button. 

 
 
 
 
 
 
 
 
 
 
 
 

4. Now you are logged on your account, where you can find the selected parts you saved 

in your Bookshelf. 

 
 
 
 
 
 
 
 
 
 
 
Example: 
 
 To save material into your Bookshelf: 

1. Select the paragraph. 

2. Right click in the selected area. 

3. Choose “Add To Bookshelf”. 
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  If you go back now to access your Bookshelf using the tab “Bookshelf”  
 

 

 

 

 

 

 

 

 

 

 

 You can see below the selected parts saved in your account. 
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VIII. How to Access Blackboard 
 

What is Blackboard? 
 
Blackboard is a course management tool for instructors who want to deliver part or all 

of their course materials and instruction online. It is accessible via any Web browser, 

Blackboard course sites provide many useful administrative and interactive 

communication features which allow for file sharing, online assessments, discussion 

boards and collaborative group work. Please visit this link for online material and 

demos: http://www.blackboard.com/quicktutorials/quicktutorials.htm  

 

How to Login to Blackboard 
 

1)  Click on the Internet Explorer icon to open up your web browser. 
 

2)  In the address field, type the PMU Website http://www.pmu.edu.sa then press  

     Enter or write on the Address bar the Blackboard link http://bbappsrv.pmu.edu.sa  then         

press Enter or Go. 

 
 

 
 
 

3) Click the shortcut link. Blackboard 
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4) When you will get the Site of Blackboard, click on User Login. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Blackboard Login authentication window will appear. Type your Blackboard Username 
then click login. 
 
 
 

 
 
 
 
 

 
 
 
 
 

Note: If you don’t have a user name and password for Blackboard, please contact the 
Blackboard Administrator at Ex: 9272 or send an email to ITD-bb@pmu.edu.sa 
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IX. How to Access Banner  
 
Write on the Address bar the Blackboard link http://www.pmu.edu.sa then press Enter. 
        

 
 

Click the link. Self Service  
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

Banner Self Service Login Menu will be displayed.  
            Now you will be prompted to login.  

             For Example: Username, enter nchanane (your Banner ID number)   

                                        Password, enter hello (your Banner Password).   

   Note: - The password is case sensitive (capital letter and small letter are different) 

            -  If you don’t have a use name and Password please contact the MIS team. 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

For more information about Banner Self Service, please refer to Banner Self Service 
Faculty and Advisor Guide. 



IT Welcome Package, August, 2009                                                                        Page 52 / 56 

 

PMU/ITD/TT/NC/06002 (IT Welcome PackageEV2.1)                                                                              Final 
 

 

XI. Library Management System (LMS)  
 

Write on the Address bar the Blackboard link http://www.pmu.edu.sa then press Enter. 
        

 
 

Click the link. Self Service  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
What’s LMS? 

 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
         Please visit the Library “LRC Building” for more information about using the library services. 
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XII. Intranet 

 
The PMU Intranet has been designed to Faculty and staff to access most of internal services quickly 

(e.g. in-house applications, useful forms, documentation and user guides for all application systems 

in PMU, etc..). PMU Intranet is a password protected; that only faculty and staff have granted access 

to PMU internal services.   http://intranet  

 

 
 
 
 
 
 
 
 
 
 
 
 
 

XIII. E-Forum 

 
E-Forum is an online place for PMU Community where they can open any discussion forum. On 

eForum all the discussions are public. PMU Community can talk about courses, games, events, ads, 

etc.  http://www.pmu.edu.sa/enn/forums.asp  
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Technical Advice 
 

From your IT Help Desk 
 
 

Question:  I’ve occasionally noticed, especially after a weekend or holiday period, that I’m 
unable to receive emails as my mailbox is full. How can I avoid this from happening? 
 
Background:  Each employee and student at PMU has a set amount of storage space 
allocated on the university’s servers for storage of email traffic. As this space is limited, the 
server automatically downloads incoming emails to your desktop computer for your access.  
Unfortunately if you turn your desktop computer off, the server is unable to download your 
incoming email and you can easily exceed your storage limit if you receive large email 
attachments. 
 
Solution:  Never turn your desktop computer off even if leaving the university for an 
extended period such as a vacation. In case of using a laptop please inform our Helpdesk to 
extend your storage temporary.   
 
 
To avoid unauthorized usage of your computer, when you leave the area where your desktop 
is located you need to “Lock” your computer by following the following steps: 
 

1. Simultaneously hold down the <Ctrl> and <Alt> keys and then press the <Del> key. 
2. Select the “Lock Computer” option. 

 
      To “Unlock” your desktop: 
 

1. Select Ctrl-Alt-Del again 
2. Enter your personal password  

 
If you have any questions, please contact the PMU help desk. 
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